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HTML BASICS Lecture 1  By Robert Berdan  2004 © 

Why it is valuable for you to know HTML 
 
The World Wide Web (WWW) is a component of the Internet that connects more than 30 million 
people and this network of computers is growing exponentially. This vast telecommunications 
network is a powerful commercial and educational resource. What differentiates the WWW from 
the Internet is that the WWW supports embedded multimedia. For many years the Internet and 
then the WWW was used primarily to exchange electronic mail (e-mail). The WWW is now 
transforming the way we do business, learn and have fun. Many companies provide information, 
sell their products or recruit employees via the WWW. Many educational institutions are 
experimenting with the delivery of educational content via the WWW. On the WWW in the future 
we may take virtual vacations. At the present the WWW is the only way we can visit the planet 
Mars. 

Hyper Text Markup Language, or HTML, is the skeleton on which content for the world wide web 
is constructed. HTML requires no previous programming experience and is easy to learn. 
Mastering HTML gives you the power to create content for the WWW. Knowing HTML will allow 
you to publish your own book, music, poetry, art work or setup a virtual business. Many folks 
share their creative talents or offer their skills by presenting their resume or portfolio on the 
WWW. A web site can consist of a single page or multiple pages that in turn may include 
multimedia: animation, sound, graphics, movies and even virtual environments. These features 
can be used to produce a marketing brochure that generates business or helps your company 
provide better customer service. In fact there is no cheaper way to produce a color catalog of 
your products than to put it on the WWW. Furthermore, since information changes rapidly today, 
it is necessary for organizations to have people that can update the information they place on the 
WWW on a regular basis. Many organizations also use HTML documents to distribute information 
internally on their internal computer networks called Intranets. Creating material for the WWW 
can also be fun. Some folks engage in it simply because it allows them to share their interests 
and talents with others on this global network. The Internet and WWW have made it possible for 
any individual to communicate or broadcast information on a global scale and HTML is the "pen" 
that allows you to do this. 

The material contained here is a pre-cursor to the development of a full interactive on-line course. 
In the future we plan to ad animation, video, sound, and interactive tests. We also plan to extend 
the lessons to include the insertion of images, frames, forms etc into HTML documents.If you are 
following the along the tutorial and can not figure out where you might have made a mistake in 
HTML, just copy and paste the code from these pages into Notepad, save and then view it in your 
browser. We welcome your comments or suggestions, feel free to contact us 
rberdan@scienceandart.org. 

Learning Objectives 

Here is what you will be able to do when you complete each objective. 

Recognize the structure of HTML tags  

Insert four basic HTML tags  

Insert paragraph tags  

Save and organize HTML files  
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View a web page using a browser  

Insert common text formatting tags  

Add horizontal rules  

 
INTRODUCTION 

1. What is HTML? 
Hypertext Markup Language (HTML) is a scripting language used to create documents for 
presentation on the World Wide Web. Unlike other programming languages, scripting languages 
are interpreted directly and are not compiled into machine code in order for the computer to 
understand them. Scripting languages are easier to learn than most programming languages. 
HTML was also designed to be computer platform independent. HTML was invented by Tim 
Berners-Lee while working in the European laboratory of Particle Physics. The first version of 
HTML was released in June of 1993. HTML features hyper-linking, which can be underlined text 
or an image which when clicked on can automatically transport you to another document, web 
site multimedia file or e-mail address. Hyperlinks connect related information and make 
navigating the vast array of information easier. In order for text or images to be displayed on the 
WWW, the information must be encoded in the form of HTML. 

2. Different Versions of HTML 
HTML is changing and evolving. The current version, at the time of this writing is 4.0. Each new 
version supports new features and new HTML TAGS. The good news is that for the most part 
updated versions of HTML tend to build on previously developed rules. Therefore, understanding 
how to read and write basic HTML will be useful no matter what version comes along in the 
future. 

3. Viewing HTML Documents in a Web Browser 
Viewing HTML documents requires a compatible web browser. The two most popular ones are 
Netscape Communicator 4.0 and Internet Explorer 4.0. There are other web browsers used on 
the WWW such as Lynx and Mosaic, but they constitute only a small percentage of web users. It 
should be noted that HTML documents can look slightly different on different web browsers and 
some features of HTML are only supported by one company’s browser. In this course we 
endeavor to use HTML that works with both major browsers or we will offer alternative solutions 
so that you will see or hear the same thing no matter which major browser you choose. 

4. Creating HTML documents 
HTML documents can be produced using any text editor or word processor, the only stipulation 
being that the file must be saved as a text only file and must be given the file extension .html or 
.htm. The file extension identifies the document as one containing HTML to a web browser like 
Internet Explorer or Netscape Communicator. On an IBM personal computer or compatible 
running Windows you will use Windows Notepad, and on a Macintosh computer you will use 
Simple text or Teach text editors, to create HTML documents. 

5. WYSIWYG HTML Editors 
Recently there has been a proliferation of programs called what you see is what you get or 
WYSIWYG (pronounced wizy-wig) HTML editors (e.g. Adobe PageMill, Microsoft Front Page, 
Macromedia Dreamweaver, Hot Metal Pro, Claris Home Page, GoLive CyberStudio etc. ). 
Netscape 3.0 Gold, Netscape 4.0 and Internet Explorer 4.0 also include WYSIWYG HTML 
editors, although they have limited abilities. What WYSIWYG HTML editors attempt do is make 
the creation of web pages easier by writing the HTML code for you while you use them much like 
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a word processor or desktop publishing program. They do indeed make creating web pages 
easier and faster and many professionals use them to save time. However, without a basic 
understanding of HTML and file paths you might never be able to fix a problem or do more than 
the HTML editor permits. Furthermore, all HTML editors allow you to modify and edit HTML code 
directly so knowing how do this will turn out to be valuable to you in the future and will permit you 
to choose and use whatever HTML editor you like. 

  

OBJECTIVE ONE 

When you complete this objective you will be able to… 

Recognize the structure of HTML tags 

Identify the basic structural components of an HTML TAG  

Describe what an attribute is and where it appears in an HTML TAG  

3. Identify several HTML TAGS that do not require an ending TAG 

Learning Material 
HTML tags are commands that are type written between the greater than < and less than > angle 
brackets. Most of the time HTML requires a "start" TAG and an "end" TAG. The end TAG is 
always preceded by a forward slash /. 

<TAG>text goes here</TAG>  

Text typed within the angled brackets <> is not case sensitive, in other words it does not matter 
whether you use capital letters, lower case letters or a mixture of the two when typing HTML 
TAGS. <TAG>, <tag> or <Tag> all work fine. In this document TAGS will appear red in color for 
easy identification. 

WARNING! Don’t forget to type the forward slash or angle brackets when typing in TAGS! If you 
forget, you may not see anything in your browser when you view your documents, this is a 
common mistake. And, by the way – spelling counts when it comes to TAGS! File names used 
within TAGs are case sensitive. Names of images, sounds etc. must be typed exactly as they 
have been named and saved. 

Attributes: Some HTML tags have additional features called attributes that are contained within 
the angle brackets. Attributes may be used to determine the width and size of an object or 
whether or not a sound or movie starts automatically or waits for a user to click on it first. 

<HR width="50%"> width="50%" is an attribute of the HR TAG 

Attributes often include specific parameters. Attributes are contained with straight ("") quotations, 
do not use ("") curly quotes. 

Positioning TAGS 
You will often want to use several TAGS together called "nesting". Pay attention to the order of 
the TAGS you use. The examples below use fictitious TAGs; <TAG-1> and <TAG-2> do not 
really exist they are used here as generic TAG examples. 
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Correct Positioning (nesting) of TAGS 

<TAG-1><TAG-2>Word</TAG-2></TAG-1> 

Incorrect Position of TAGS 

<TAG-1><TAG-2>Word</TAG-1></TAG-2> 

The ending TAG-2 should be on the inside of </TAG-1>, in its current position <TAG-2> would 
have no effect on the contents "Word" between <TAG-1>.</TAG-1> 

Unpaired TAGS 

Some HTML tags do not require an ending TAG, for example: <HR> and <BR> TAGS have no 
ending tag. 

  

OBJECTIVE TWO 

When you complete this objective you will be able to… 

2. Insert four basic HTML tags 

Learning Activity 

Do the following: 

Start your basic text editor. To start Notepad, go to the start button on the lower left of your 
Windows screen, click and drag on the open menu and choose the Programs Menu, accessories 
submenu and then Notepad. If you do not find Notepad go back to the start menu, choose find 
and search for "Notepad". When you find the program double click on the icon in the find window 
to start the program. If you do not find it, you may have to load it from your Windows CD. 
Alternatively you can also use Windows Word pad. If you are using a Macintosh computer, you 
must first find and start Teach Text or Simple text.  

Type in the following four TAGS in the text editor window in the order they appear (HTML, HEAD, 
TITLE AND BODY>. Remember it does not matter whether you use all caps, lower case or a 
mixture. For display and ease of editing we will type tags in all capital letters. Within the TITLE 
TAG include a title of your document as shown below. These 4 TAGS are found in all HTML 
documents.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
</BODY> 
</HTML>  

Once you have typed this information into Notepad, check it carefully then move onto the 
next objective.  
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If you saved the document now you would only see a blank page with a title at the top of 
the web browser. The TITLE identifies the document by name and if you were to create a 
bookmark (or favorite site mark) using your web browser, the title would appear in the 
bookmark menu. Otherwise the title is visible at the very top of your browser.  

OBJECTIVE THREE 

When you complete this objective you will be able to… 

3.Insert paragraph tags 

Learning Activity 

Complete each of the Learning Activities listed below. 

1. Insert a sentence into the document by typing a phrase that will be enclosed within the 
paragraph TAGs <P>Every body loves cheesecake</P>. To do this you will need to enter 
several blank spaces between the body tags. You can do this by placing the cursor after 
the first <BODY> TAG and pushing your Enter or Return key on your keyboard several 
times.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<P>Every body loves cheesecake</P> 
</BODY> 
</HTML>  
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TIP Typing your TAGS all in uppercase makes it easier to find typographic errors. Also 
placing the TAGS all in one line like that shown below often makes it more difficult to read 
your code. It is recommended that at least initially you follow the form we use in our 
examples.  

<HTML><HEAD><TITLE>First Web Document</TITLE><BODY></BODY></HTML>  

OBJECTIVE FOUR 

When you complete this objective you will be able to… 

4. Save and organize HTML files 

Learning ActivitySave your HTML document 

1. To save the file, go up to the File Menu in Notepad, choose file > save. Before you 
name your file, navigate to your desktop so it saved there (see picture below).  

2. Name the file 

Name the file index.html and save it on to your desktop. Minimize Notepad or move the 
notepad window over on your screen so you can see that the index.html file exists on 
your desktop. When you type the filename index.html, use all lower case letters.  

 

Learning Material 
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IMPORTANT if you are creating a new web site, your home page must be called 
index.html. If you do not do this, when you load the page on a remote server via the 
Internet your home page will not open in the browser, instead you will see a list of your 
files. Some servers will not support using a capital letter in the file name such as 
Index.html. The only time you would not name your web page index.html is if you are 
creating pages for a pre-existing web site that already has an index.html file or you 
already have an index.html file in your web site folder. You can only have one index.html 
file per web site. Other pages on your web site can be given almost any name so long as 
they conform to the file naming guidelines below and end with .html or .htm extension.  

In this example you will save the file to the desktop so it easy to find and easy to discard 
when you are finished. Normally when you begin to create a web site you first create a 
folder, then save all files, text, images etc. into one folder. This way when you link the 
files or move the folder the links will be relative to each other.  

FILE PATHS – Relative vs. Absolute  

When you create a web site and insert links to other web pages and graphic files, the link 
includes its’ location on your computer. If the file is in the same folder or a subfolder 
located where the index.html page, its’ file path is a relative one.  

For instance, if you created a link to an image file called leaf.jpg to your index.html file 
you would add the TAG and file path <img src="leaf.jpg">. The file path is ="leaf.jpg". If 
the file was in a subfolder where the index.html files was stored you would provide the 
following relative file path <img src="/subfoldername/leaf.jpg">. When you create a web 
site you almost always want to use relative path linking. The easiest way to do this is to 
ensure all your files are in the same folder as the index.html file when you create links to 
the individual files.  

Absolute file paths include links to files on other servers or within a different folder on 
your computer e.g. <img src="http://www.site.com/folder/leaf.jpg">. This file path is 
absolute since it specifies the position of the leaf.jpg image on another web site. Absolute 
file paths require that the entire path be included when you create the link. In general 
when you create you own web site you will want to avoid absolute file paths unless you 
are creating a direct link to another site. Having an incorrect file path is the most common 
source of frustration for students learning HTML especially if they used a WYSIWY HTML 
editor. These editors allow you drag and drop images onto your pages and they create 
the links no matter where they are on your computer. The problem comes when you go to 
move your folder with your web site or upload it to a server, many of the files can no 
longer be found and you will see blank images in your browser window. To fix this 
problem, make sure the file you linked to is in the same folder as the index.html file and 
the file path is a relative one. If the file is in the folder then edit the file path by removing 
the absolute parts (e.g. E:\Desktop\windows… and leave only the relative information.  

   

TIP when naming files and folders follow these recommendations:  

1. always use lower case letters  
2. before the file extension, keep your filenames to 7 characters or less  
3. never leave a space between the characters of a file name or a folder name  
4. If you do use split filenames be sure to include an underscore e.g. file_name.html  
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5. If you transfer files between the Mac and PC, the filenames may change to capital letters, 
have an exclamation mark placed in front (e.g. !file.html) or long filenames will be 
truncated. If this occurs you will have to rename the files before they will work properly.  

6. Do not include illegal symbols such as &$*\ in a file name.  
7. When choosing file names try to pick names that are informative  

Browsers will not recognize file names with empty spaces. Since the browser does not recognize 
empty spaces it will insert special characters into the spaces and the link to that file will not work. 

  

OBJECTIVE FIVE 

When you complete this objective you will be able to… 

5. View a web page using a browser 

Learning Activity 

1. Start Your Web Browser 

Start the Internet Explorer web browser. Go up to the File menu, choose Open, Browse, 
navigate to your desktop where your index.html file should be, select the file with your 
mouse pointer and choose open.  

2. View your document in the Browser 

If you did all the steps correctly you should see a sentence in your browser saying 

Every body loves cheescake in your web browser window. 
Also, look at the top of your browser you should see your title. 
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If it worked – Congratulations, you wrote your first web page! Proceed to the next 
objective.  

Learning Material 

Once you can save your HTML files and view them in your browser from here on making 
changes is simple matter of editing your html document and re-loading or opening it in 
your browser to see the changes. The most common problem you are likely to encounter 
is typographic errors. The other possible problem you may encounter with Notepad, is 
that when you go to re-open or choose a file, no files are visible on your desktop. When 
this occurs, make sure you choose view all files in the bottom selection box within 
Notepad. Notepad defaults to opening *.txt files and in this mode will not display *.html 
files. Another problem you may encounter when loading modified pages into your 
browser using the reload or refresh buttons is that sometimes the changes you made will 
not show up. When this occurs use the menus to re-open the file. Browsers store 
previous pages in their cache memory and the re-load button sometimes re-loads the 
same unmodified document held in its cache.  

oProblems? If you don’t see any text in your web browser, go back to Notepad, and if 
your HTML tags are still visible, check them very carefully against the information in this 
module. Then save the document again, but choose save as and type index.html again. 
The file extension.html (period-html) must be present without any additional spaces or 
periods in between. Maximize or restart Internet Explorer and open the index.html file 
again.  

If you still do not see any changes you can do one of two things. In Internet Explorer go 
to View> Source to view the source HTML code. In Netscape choose View > Page 
source. This feature permits you to view the code of any HTML document, but you can 
not edit the code, only view it. Check your code for typgraphic errors and missing 
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brackets or slashes. If you find an error return to the file in Notepad, fix and save the 
document again.  

 

   

TIP The picture above shows the source code window. You can not edit this code, but 
you can identify mistakes or learn how someone else did something using HTML or 
JavaScript. It is possible to copy code from this window by selecting the text with you 
mouse (click and drag) and in Windows hit your Ctrl-C keys to copy the code into 
memory. Then open your HTML editor and choose> paste to insert the code into your 
document.  

  

OBJECTIVE SIX 

When you complete this objective you will be able to… 

6. Insert common text formatting tags 

Learning Activity 

TEXT FORMATING TAGS BOLD, ITALICS AND UNDERLINE 

To format text in your document you will add additional TAGS. 
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To do this: 

1. Minimize your browser window if still open and return to notepad.  
2. If the index.html file is not already loaded, then open it in notepad. You should see the 

basic tags we had before. Within the paragraph TAG we are going to nest additional 
TAGS that will make the text Bold, italics, and underlined. Lets do one at a time.  

3. Insert the TAG to make text bold <B></B> for the entire sentence as shown below.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<P><B>Every body loves cheesecake</B></P> 
</BODY> 
</HTML>  

1. Save the file  
2. Re-open index.html and view it in your web browser.  

The text should appear bold. Repeat these steps above, but replace <B></B> TAGS with <I></I> 
italics TAG, then the <U></U> underline tags. When you completed this we will move onto 
centering your text. There is also a special tag for putting addresses on your page 
<ADDRESS></ADDRESS>. This tag will also make the text appear in italics. 

CENTER TAGS 

1. To center your text place the <CENTER></CENTER>TAGS outside your paragraph TAGS. 

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<CENTER><P><B>Every body loves cheesecake</B></P></CENTER> 
</BODY> 
</HTML> 

2. Save and view your document in your web browser. 

The text should appear bold and centered if you did this correctly. 

The position of the TAGS is important. If you place the <CENTER> TAG immediately after the 
<BODY> TAG and then again at the bottom of the document immediately above the </BODY> 
TAG, everything in your document will be centered. If you place TAGS around a single word, only 
that word will be modified. 

HEADING TAGS 

Heading or header TAGS increase the size of the TEXT and make it bold. Headings are used to 
announce new sections of a document. HTML provides six different sized Headers <H1></H1> to 
</H6></H6> 
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<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<H1>Largest Heading</H1> 
<H2>Larger Heading </H2> 
<H3>Large Heading</H3> 
<H4>Small Heading</H4> 
<H5>Smaller Heading</H5> 
<H6>Smallest Heading</H6> 
<P>Normal Text shown here<P> 
</BODY> 
</HTML> 

 

Your screen should look like this screen shot. If your text appears differently, check that you did 
not forget a forward slash in one of the TAGS and check that you did not put in a wrong number 
following one of the heading tags. If you can’t fix the problem copy and paste the code above 
directly into Notepad and save the file. If you wanted to center a header TAG – enclose it within 
the <CENTER></CENTER> TAGS as described earlier. When you use Headings make sure you 
use them consistently, do not mix different sized headings for similar content. You will learn to 
change font colours in PageMill later in this course. 

SUPERSCRIPT AND SUBSCRIPT TAGS 

If you would like to put equations in your document you will need to use the superscript and 
subscript TAGS <SUP></SUP> and <SUB></SUB> 

We are going to enter the equation X2 + Y2 = X1 
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1. To begin, open your index.html file.  
2. Select and delete the material you have within the body TAGs or start a new page.  
3. Type in the Equation with the <SUP> and <SUB> Tags as shown below.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<P>X<SUP>2</SUP>+Y<SUP>2</SUP>=X<SUB>1</SUB></P> 
</BODY> 
</HTML> 

1. Save the file and view it in your web browser, it should appear like the equation above. 

BREAK TAGS 
When you type a paragraph of text in a HTML document it starts at the left edge and continues on 
to the right edge where it automatically wraps to the next line. Exactly where it wraps depends on 
how the viewer has sized their web browser. If you drag the browser window and make it smaller 
the text will automatically wrap at the edge. You can force a sentence to wrap anywhere in a line 
of text by inserting a <BR> TAG. The break TAG does not require an ending TAG. 

1. Insert the <BR> tag using a long sentence as show below.  
2. Start Notepad and type in the HTML TAGS and text shown below  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<P>If you have a sentence you want to wrap here<BR> 
by inserting the single break TAG the sentence can be forced to wrap at any location</P> 
</BODY> 
</HTML>  

2. Save your file and view in your web browser  
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Note the sentence wraps right after the word here.  

BLOCKQUOTE TAGS 
From the example above you can see that text usually starts flush to the left of the browser 
window and extends over to the right side of the window unless you insert a <BR> TAG. When 
entering several paragraphs of text, many folks find it easier to read if there is some empty space 
around the text. For this reason books have margins. These areas allow the eye to rest and make 
for a more professional presentation. The <BLOCKQUOTE></BLOCKQUOTE> TAGS produce a 
margin around the text in your web pages.  

1. Open Notepad and type in the following information. Leave the previous sentence and if you 
want to save time, just copy and past the paragraph above into your document.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<BLOCKQUOTE> 
<P>If you have a sentence you want to wrap here<BR> 
by inserting the single break TAG the sentence can be forced to wrap at any location</P> 
<P> From the example above you can see that text usually starts flush to the left of the browser 
window and extends over to the right side of the window unless you insert a <BR> TAG. When 
entering several paragraphs of text, many folks find it easier to read if there is some empty space 
around the text. For this reason books have margins. These areas allow the eye to rest and make 
for a more professional</P> 
</BLOCKQUOTE> 
</BODY> 
</HTML>  

2. The <BLOCKQUOTE> TAGS can be inserted around a single sentence, or paragraph, but 
often they are placed near the beginning and end <BODY> TAGS. This way the entire page will 
be surrounded by a Margin.  

1. View the results in your web browser, then remove the <BLOCKQUOTE> TAGS and 
note the difference in appearance.  
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Your screen should look like these above with the <BLOCKQUOTE> TAGS and below without. 

  

SPECIAL CHARACTERS 
In order to display special characters, symbols and diacritical marks on a web page it is 
necessary to insert specific special codes for each. These usually must be typed directly into the 
HTML source code although some HTML editors are beginning to offer support for this feature. A 
list of the special codes for different characters can be found on page 235 of your text book.. 

To insert a copyright © for instance you need to do the following. 

1. Start Notepad and either open a pre-existing index.html file or start a new file.  
2. Enter type within the body TAGS  



 16

<CENTER><P>This document is copyright &#169;</P></CENTER>  

The special code for the © symbol is &#169;  

1. Save your file, open and view it in your browser. You should see the copyright symbol 
after the word copyright.  

2. Try these additional examples: ® &#174; © &#153; É &#201;  

5. Some symbols have two special codes for example for É you could also type &Eacute; 

  

OBJECTIVE SEVEN 

When you complete this objective you will be able to… 

7. Add horizontal rules 

Learning Activity 

1. Open your index.html file in Notepad and between the body tags insert <HR>, this TAG 
does not require an ending TAG. You can use your previous index.html file or you can 
start a new one.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<HR> 
</BODY> 
</HTML>  

   

1. Save the file, open it and view it in your Browser  

Some HTML TAGS support additional features called attributes. Some attributes can control the 
height, width, and color of objects on a page. Attributes may control when a movie starts playing 
or whether or not it loops continuously or just once. You will now add several attributes to the 
<HR> TAG  

1. Re-open your index.html file with the horizontal rule in Notepad and below it include the 
following TAGS. You must leave a space between HR and WIDTH.  

   

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
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<BODY> 
<HR> 
<HR WIDTH="50%"> 
</BODY> 
</HTML>  

1. Save and view the file in your Browser. You should see two horizontal rules, the lower 
one should take up 50% of the browser width. The attribute width="50%" makes the 
horizontal rule half of the browser width even if you change the browser window size. Try 
it, make your browser window smaller and watch the horizontal rule shrink and grow 
along with it. Attributes that include % are flexible so that they accommodate different 
browser widths. Sometimes you will not want the object (e.g. a table) to change size 
when the browser width changes as this may disturb your page layout. To prevent the 
horizontal rule from changing in width, you can instead enter a fixed pixel width. Enter 
width="450" as an attribute. 450 represents the number of pixels wide the horizontal rule 
will be. Try it.  

5. Open your index file in Notepad and type underneath the previous horizontal rule TAGS <HR 
width="450">, then open and view your document in your web browser.  

   

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<HR> 
<HR WIDTH="50%"> 
<HR WIDTH="450"> 
</BODY> 
</HTML>  

   

1. Once you open your file in the browser, change the size of your browser’s width and 
notice that the bottom horizontal rule does not change in width.  

   

1. It is possible to have more than one attribute within the angle brackets of TAG. Add these 
TAGS to the previous file. Note size attribute does not support % and must be a fixed 
pixel height.  

   

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<HR> 
<HR WIDTH="50%"> 
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<HR WIDTH="450"> 
<HR WIDTH="200" SIZE="40"> 
<HR NOSHADE> 
<HR SIZE="20" NOSHADE> 
</BODY> 
</HTML>  

   

Horizontal rules may look a little different in different browsers.  

If you view the same file and code above in Netscape, the rectangular bars will have round 
corners. On older browsers with gray backgrounds, the horizontal rule will have an embossed 
look to it and the NOSHADE command will make the horizontal rule black instead of gray.  

   

1. Finally, one more attribute you can apply to a horizontal rule TAG is ALIGN=LEFT or 
ALIGN=RIGHT, try adding a single horizontal rule with a width of 450 pixels and 
ALIGN=LEFT.  

<HTML> 
<HEAD> 
<TITLE>First Web Document</TITLE> 
</HEAD> 
<BODY> 
<HR WIDTH="450" ALIGN=LEFT> 
</HTML> 

 

Learning Material 

Horizontal rules form dividers on a web page and can be used to isolate sections. Horizontal rules 
can vary in height, width and appearance. Try not to overuse too many rules on your page. In 
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later modules you will learn how to create and use colored rules that are actually graphic files. 
The <HR> TAG can also include attributes that define additional features such as width, size, 
appearance and alignment. It is possible to have multiple attributes within a single TAG. The 
<HR> TAG is also one of the few TAGS that does not require and ending TAG. Finally, some 
TAGS will appear different in different browsers, <HR NOSHADE> is rectangular in Internet 
Explorer, but has rounded corners when viewed in Netscape Communicator. 

   

 

  

Course Self Test 

1. Each HTML document must have 4 paired tags which are:  

a) 
b) 
c) 
d)  

   

1. What does the abbreviation HTML stand for? 
2. What is the current version of HTML? 
3. Write the HTML code for inserting the following quotation in an existing HTML document: 

"Imagination is more important than knowledge" 
The sentence above should be in italics and centered on the page.  

   

1. Write the HTML code for inserting the following equation into a web page:  

A2 + B3=C5  

   

1. Write the HTML code for a horizontal rule that takes up half of the browser width.  
2. Name two WYSIWYG HTML editors  
3. The home page of each web site must be called?  
4. How do you identify a HTML document?  
5. Where does the title of an HTML document appear on the web browser?  
6. If you wanted to indent a block of text, what HTML TAG would you use?  
7. If you wanted to force a sentence to wrap at a specific point on the page, what HTML 

TAG would you use?  
8. In order to insert a copyright symbol on the page what special character would you need 

to add to your HTML document.  
9. Which of the following file names are illegal or poor form a) running bear.jpg b) 

slimtonothingfile.html c) jims#2 file d)leaf.jpg e) R_fold  
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10. Name two HTML TAGS where an ending TAG is not required.  
11. Which file path is relative and which is absolute a) "E://folder/image.jpg b) www.site.com 

c) "/images/image.gif" d) "leaf.jpg"  

   

 
Self Test Answers  

  

1. a) <HTML></HTML> b) <HEAD></HEAD> c) <TITLE></TITLE> d) <BODY></BODY>  
2. Hypertext Markup Language  
3. Version 4.0  
4. <CENTER><P><I>"Imagination is more important than knowledge"</I></P></CENTER>  
5. <P>A<SUP>2</SUP>+B<SUP>3</SUP>=C<SUB>5</SUB></P>  
6. <HR WIDTH="50%">  
7. PageMill, Dreamweaver, Front Page, Hot Metal Pro, Claris Home Page  
8. The home page of a web site is given the name index.html or index.htm  
9. You identify an HTML file by its file extension .html or .htm  
10. The title appears at the very top of the browser within the colored strip  
11. <BLOCKQUOTE></BLOCKQUOTE>  
12. <BR> Break TAG  
13. You would enter the special code &#169;  
14. a) b) and c) are illegal or use poor form  
15. <HR> and <BR> TAGS  
16. a) & b) are absolute file paths c) & d) are relative file paths  

Assignment 

Create a web page with a paragraph or two about your hobbies or interests. Include a title, a 
heading e.g. Jim’s Hobbies. The paragraphs should have margins around them so they do not 
abut up to the edge of the browser. Use several horizontal rules to break the page up into 3 parts, 
include your mailing address and phone number. Create a folder with your name and save the 
HTML file as index.html into your folder. 

 


